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Integration Summary

The ITSM40ffice integration enables you to create, manage and follow-up your
tickets from a client-based panel interface interacting with Outlook.

e Create an Incident semi-automatically recompiling data from the email (contact,
summary, Notes, date, and time of the request)

e Manage and follow-up of your ITSM workload (assign, dispatch, add work info)

e Intuitive Search (Ticket number, keywords, dates, priority....)

e Drag and drop of attachment into the ticket be added as a work info

(1) Before doing any operation on the Remedy platform it is highly recommended
to perform a Database Backup to perform a roll back if needed.
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Upgrade preliminary steps
1. Preparing your v1 system for upgrade to v2

Before upgrading your system, you will need to perform the following actions using BMC
Remedy Developer Studio.

Schema Name Type Action \
ITSM40ffice:Data:Locale Form X Delete
ITSM40ffice:CHG:Changelnterface Form X Delete




ITSM4Office

BMC Remedy AR System

(i) The following deployment should be done using the BMC Remedy Developer

Studio.

2. Import of the Server Component Remedy

Application

From the main menu, select File > Import and
expand BMC Remedy Developer Studio.

Select Application and click Next

Select Server Name and click Next.

Server Component - Integration Guide v2.0.0.3

B Import

[m} >
Select \“
Select an import wizard:
w (= BMC Remedy Developer Studio
0 Application
Object Definitions
View Definitions
@ < Back MNext = Finish
B Import Application m] X
Select Server
Select the AR System server for this operation to proceed.
@ itsmdev
@ v CEET] |
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2 Import Application [m} x
Select the proper Application Definition file Import File
ITSM4Office App vX.def from the appropriate Selectthefile o impert from
location and click Next. Impart File: CA.\TSMAOffice App for v3.0xdef

® < Back Mext » Finish Cancel

1 Note

v For AR v 8.x import the ITSM4Office App for v8.x.def file
v" For AR v 9.0.x import the ITSM40Office App for v9.0.x.def file
v" For AR v 9.1.x/18.x/19.x import the ITSM4Office App for v9.1.x.def file

2 Import Application O X
Make sure to select: Application Selection
Select the application to import
b Replace ObjeCts on the DeStination Application To Import: | ITSM for Office ~
Server
. Replace Objects on the Destination Server
¢ Delete Excess Fields Delete bxcecs Ficlde
e Delete Excess Views Delete Excess Views
[[] Retain Excess Schemas
. Handle Conflicting Types: ~
and click Finish.
® < Back Next = Cancel

=
M Known Errors

[v9.0.x] ERROR (168) / ERROR (412) after importing ITSM40Office App for v9.0.x.def
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3. Import the Other Object Definitions

From the main menu, select File > Import and
expand BMC Remedy Developer Studio.

Select Object Definitions and click Next

Select Server Name and click Next.

Select file ITSM40Office WS.def from the
appropriate location and click Next.

2 Import [m] X
Select \A‘
Select an import wizard:
‘ type filter text ‘
~ [= BMC Remedy Developer Studio
[ Application
Object Definitions
View Definitions
@ < Back Next > Finish
B Import Objects m} X
Select Server
Select the AR System server for this operation to proceed.
[ itsmdev
® ST - [
3 Import Objects m} X
Import File
Select the file to import from
Import File: CAATSMAOffice WS.def 1[5
® e R [
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2 Import Objects O X
Make sure to select Replace objects on the Object Selection
Destination Server and click Finish. b Ry o o 10 2dc/remove

Name . Al Add..

IIMSO-AST_AssetPeople_AssetBase
TIMS0-AST_BaseElement

@ MS0-CFG_GenericCompanyModulelockUp Remove All
@ MSO-CFG_Service_Catalog_LookUp

@ M50-CHG_Changelnterface_Create

IIMS0-CHG_ WorklLog

I MS0-COM_Company

EIMS0-CTM_People

EIMS0-CTM Support_Group

@ MS50-CTM_Support_Group_Assoc_LeokUp
@MSO-HPD_In[ideﬂtlntar‘face_(reate v
< >

Remove

[ Replace Objects on the Destination Server
[] Delete Excess Fields
[] Delete Excess Views
["1Replace Full Text options
[[] Replace Display Properties
[[]Replace Application Owner

Handle Conflicting Types: | Display Conflict Error ~

® o [ e

! Note

v" For AR v9.1.x and later import the incremental ITSM40Office WS v9.1.x.def
definition file in addition to the Base WS Definition.

Follow the same steps to import the Object S Import Objects o x
Definition file ITSM4Office Filters Patch.def Import File

Select the file to import from

Import File: C\JITSMAOfice Filters Patch.def

@ < Back DNext > Einish Cancel
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Description of these filters:

CheckForTemplate_Notes_o : Correct a bug with
the notes field in the create Incident interface

SetPRTY_o and SetReportedDate : Allow to Set
the reported date according to the received time
of the email

ResolveTemplatelnstancelD : Resolve template
ID to template instance ID

8 Import Objects

Object Selection

All objects from the below list will be imported. To add/remove
ohjects to the list use Add/Remove button.

~
MNarne

HPD:HI:Createlncident_017_CheckForTemplate_Notes
HPD:HI:Createlncident_017_CheckForTemplate_Notes_o
HPD:HI:Createlncident_030_SetPRTY
HPD:HIl:Createlncident_030_SetPRTY_o

@ HPD:HI:Createlncident_030_SetReportedDate

@ MS0:HPD:HI:Createlncident_ResolveTemplatelnstanceld
@ MS0:HPD:HI:Updatelncident_135_GetClinfo

| M50:HPD:INC:SetVen dorReportedDate_31%

<

Replace Objects on the Destination Server
Delete Excess Fields
Delete Excess Views
Replace Full Text opticns
Replace Display Properties
Replace Application Owner

Handle Conflicting Types: | Display Conflict Error ~

Add...

Remove

Rernove All

@ < Back Next >

Cancel

Repeat the “import as object” steps for the following Definition files

v Services.def

1 Note

In case of updating the Server Component it is recommended at this stage to Flush
the MidTier Cache as well as the local Browser cache to properly take new

definitions into account.
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4. Building the ITSM40Office Overview Console

(i) Required Permission
Administrator role is needed to access this form

In the Applications menu, a new ITSM for Office Administration menu will appear, go
to the Console.

ITSM for Office Administration »  ITSM for Office Administration Console

Incident Management

Problem Management

Preparation of the MSO Overview Console View (Step 1)

(D Do not (re)build the view using the OOTB “SHR:Union_ConfigurationConsole".
Although the Union process use the same supporting forms for fields & mappings,
the view build service will use custom workflows.

From the Install & Setup menu, click the “Rebuild Union Overview” button.

ITSM40Office Administration Console

Flush Client Cache

e Server Component Setup
Install & Setup

1.3.03

License
- : Step 1: Initial Union Overview build (View M50 _OverviewConsole)
ENEral
I Rebuild Union Cverview |I
Matching Rules
Step 2: View Form Import (MSO:Union_OverviewConsole)
From BMC Remedy Developer Studio import the “MS0_Union_OverviewConsole.def Object Definition.
Step 3: Final Union Overview build and Version specific Configuration Update
Post Install Init
! Note

This action will trigger a (re)build of the MSO_OverviewConsole View bypassing the
Enum Value conversion. Use this step to rebuild the view if you add custom field
mappings & before adding them to the MSO:Union_OverviewConsole Form

Overlay.

10
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Import of the MSO:Union_OverviewConsole definition (Step 2)

. . 2 Import m} X
From the main menu, select File > Import sl
elect

and expand BMC Remedy Developer DY
Studio. =

Select Object Definitions and click Next | 2%t meerseurce
| type filter text |

v [ BMC Remedy Developer Studio
5 Application
Object Definitions
View Definitions

® mE

. 2 Import Objects O X
Select Server Name and click Next.

Select Server

Select the AR Systemn server for this operation to
proceed.

@ itsmdev
[Fy tsmdevd iso

(@ | <k | Net> [ Ensh || cancal

. . 3 Import Objects O X
From the appropriate location, select

MSO_Union_OverviewConsole.def file
and click Next.

Import File
Select the file to import from

Import File: | C:\..iMS0_Union_OverviewConsole.def | III

(@ | <Bck | Net> [ Bnsh || cancal

11
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2 Import Objects O X

Especially in case of a server component Object Selection

All ebjects from the below list will be imported. To add/remove

update, make sure to select: objecis o the list uze Add/Remove button.

Narne

MSC:CHG:Assaciation-Cl Remaove

* Replace ObjeCts on the MS0:HPD:Association-Cl
DeStInatlon Server MSO:Union_OverviewConsole

MSO0:WOI: Association-Cl

e Delete Excess Fields TJ MS0-CHG_Associations-Cl

g MSO-HPD_Associations-Cl

o Delete Excess Views S5 MSO-MSO_Union_OverviewConsole
S MSO-WOI_Associations-Cl

S

Add...

Remove All

< >

and click Finish.

Replace Objects on the Destination Server
Delete Excess Fields
Delete Excess Views
Replace Full Text options
Replace Display Properties
Replace Application Owner

Handle Conflicting Types: | Display Conflict Error ~

Cancel

® < Back Nest >

Post install & re-configuration (Step 3)

In the Applications menu, go back to the ITSM for Office Administration console.

ITSM for Office Administration ITSM for Office Administration Console

Incident Management

Problem Management »

From the Install & Setup menu, click the “Post Install Init" button. It will trigger
workflows that will perform a version specific initialization of the application.

ITSM40ffice Administration Console

Flush Client Cache

¥ Configuration Server Component Setup
Install & Setup

License
Step 1: Initial Union Overview build (View MSO_OverviewConsole)

General
Rebuild Unien Cverview

Matching Rules
Step 2: View Form Import (MSO:Union_OverviewConsole)
From BMC Remedy Developer Studio import the “MS0_Union_CwverviewConsole def Object Definition.

Step 3: Final Union Overview build and Version specific Configuration Update

Post Install Init

12
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=
M Known Errors

[v9.0.x] ERROR (168) / ERROR (412) after importing ITSM4Office App for
v9.0.x.def (Upgrade v1 to v2)

(i) More information about the Overview Console Customization can be found on

BMC Docs:
https://docs.bmc.com/docs/display/public/itsm81/Extending+the+Overview+con

sole

The customization process remains the same and only the view build service
differs. Just remember to (re)build the View using the Install and Setup Menu.

! Note (ARERR 48747)

During the Post Install, a second pass rebuild of the MSO_OverviewConsole
View will be done, this time triggering an Enum Value Conversion.

Enum Value Conversion can sometime give error if custom enum fields were
added. Enum Values will need to be updated accordingly in the
MSO:Union_OverviewConsole form overlay to match the source form values.

cannot be found for the "TicketType" field on the
"MS0:Union_OverviewConzole" View Form. Ensure all

H The "Knowledge” selection value from "HPD:Help Desk” 3
selection values exist and try again. (ARERR 48747)

It is recommended to avoid enum fields and to use regular character fields instead
(Field Type 4).

Build/Rebuild of database union structure complete. (ARNOTE 48759)

13
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5. Server License configuration (Optional)

@ This Step is for PRO & Enterprise subscription only

In the License Tab, copy the license that was provided into the Server License field then
Save.

h d I: I# ITSM40ffice Administration Console

Flush Client Cache

ITSM40ffice Licensing

License User Licenses inuse 0

General Device Licenses inuse 0

Server License |H4SIAARAAAAEAF2PSZ0IQBCFwunmbBtdpGOBIMIm+AgKKIGX QoosIRFisKio/TiD2ZnyUNG5PtevsjaYl| | =
ycoKpFa0TKIvigygCIFRNYSJ/eAuaDewPMCPELIVOEGEZbMKUXFTAI60I2IMMEV 3ZsxfPEIGF aZIM1ezZ)
ElCwS5hTs2Gs8oqexHwgKe rNwzenBQUINTHyWWHS3g+vSe10WPpSpwisIKnzsKOtRLLSLXbeBBU4xvb
ICAADSDFLOISCUIRSJEXgOMSTnfPAPPNyDEMFeQdgQ9n55xC3sBHW3aCucdi7 TvyNSyTimfiba BT
MNbkSEprgd SvmwsKXDzE4TVyCulhbEa0VPISIZHL3KVIVDY 4NIQDY 55 TzEHDK S NGKIStKI ZgHIgivnP0ci
kMHHVSCGq'YmJOrgR3HE2PDIeZTRd9Y Bje 3SKKIZXEJSEymXVI3s4d9eeCu/mWehqwSupT OxvmmZ

CV5oazcaitd5 30omimNz4WIwwPUbO52b3K 1xjKNSIuXIPPOTgSkuFRoCVI41SKLIY 4y4hfQEZCXS
10gC4BenHI3sictD1jiTrJWBywdraxsPE62ChUBWARWAL+ ASRTKPhd2upkPQsMXj1 GT4JE0dppcii=Nivn
WfPEFh3EsnGeCAAAS]

Save

Smart IT configuration (Optional)

If you are using Smart IT, you can configure the URL in the Smart IT web path field under
General, then Save the configuration.

h d I: I% ITSM4Office Administration Console

Flush Client Cache

Smart IT Web Path |htt|J:IIdemo.itsm40uﬂDd(.corMLMsmart—iU

License SendTimeout (s) [30 H:
General o

ReceiveTimeout (5] l& H*
GellistPageSize (1000 HC

Save

14
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Known Errors

[v9.0.x] ERROR (168) / ERROR (412) after importing ITSM40Office
App for v9.0.x.def

2 BMC Remedy Developer Studio *
Imported with errors and/er warnings
Message Code *
3 One of the field/assignments in the set filter/active link/escalation definition is invalid,; ITSM40ffice:CustomUnionBuildServices 168
3 One of the field/assignments in the set filter/active link/escalation definition is invalid.; ITSM40ffice:Data:ViewDefinitionsLocalized 168
3 One of the field/assignments in the set filter/active link/escalation definition is invalid,; [TSM40ffice:UserRegistry 168
€3 One of the field/assignments in the set filter/active link/escalation definition is invalid,; ITSM40ffice:CustomUnionBuildServices 168
3 One of the field/assignments in the set filter/active link/escalation definition is invalid,; [TSM40ffice:Data:ViewDefinitionsLocalized 168
3 One of the field/assignments in the set filter/active link/escalation definition is invalid.; ITSM40ffice:Application Profile 168
3 One of the field/assignments in the set filter/active link/escalation definition is invalid.; ITSM40ffice:Application Profile 168
€3 The import file is in an incorrect format; MSQ:UCC:SourceFormLoop_BuildViewSOL_DropView! 412
3 The import file is in an incorrect format; 412
€3 The impeort file is in an incorrect format; MSO:UCC:SourceFormLoop_BuildViewSOL_CreateView'! 12
3 The import file is in an incorrect format; 412
€3 The import file is in an incorrect format; MSQ:UCC:RebuildUnionSve_DropUnionView'! 412
3 The import file is in an incorrect format; 412
3 The impeort file is in an incorrect format; MSO:UCC:RebuildUnionSve_CreateUnionView'! 12
3 The import file is in an incorrect format; 412
v

Though the ERROR (168) could be ignored, ERROR (412) will result in the following
missing filters.

v" MSO:UCC:SourceFormLoop_BuildViewSQL_DropView'!
MSO:UCC:SourceFormLoop_BuildViewSQL_CreateView'!
MSO:UCC:RebuildUnionSvc_DropUnionView'!
MSO:UCC:RebuildUnionSvc_CreateUnionView'!

ANEANERN

v/ Solution

Import as ‘Object Definitions’ the “CustomUnionBuildServices.def".

15
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[v9.0.x] ERROR (168) / ERROR (412) after importing ITSM40Office
App for v9.0.x.def (Upgrade v1to v2)

ol Remety e e %]
Unknown system error :
java.lang.NullPointerException (ARERR 8790

Lok |

v/ Solution
Restart the BMC Remedy Action Request System Server (ARS) Service(s)

16
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ERROR (552) with the MSO:Union_OverviewConsole

() ERROR (552): The SQL database operation failed.; Invalid column name
'C536870914". (SQL Server 207) Invalid column name 'C536870913". (SQL Server 207)

ITSM Service Today S
= - Submitted By Me ¥ Y

Search ITSM 2| Search -

ERROR (552): The SQL database operation failed.; Invalid column name
0 'Ch3I6BT0914". (SAL Server 207 )Invalid column name 'Ch36870913". b4
[SGL Server 207)

By Created Date~  Mewest |

It might happen that the Union Overview Console customization fails with this error,
especially in case of update when using Overlays. A simple workaround is to proceed as
follow:

1. From Developer studio, open the “MSO:Union_OverviewConsole” in best Practice
Mode.

2. Locate and select the problematic Custom Fields using the Columns IDs of the
Error Message.

LM Prioriy O -
I{ELM Statuz l{J j

[
I'Iendu:ur Group :' ':

3. CUT those fields

BLMPrioty B | nde

I{ELM Statuz : Redo

+.-’enu:|u::r Group = Open In Browser
Print

Add Fields from U_Owerview_Console

|o€' Cut

Copy
Paste
Select All

4. Save the form Overlay

17



ITSM4Office Server Component - Integration Guide v2.0.0.3

5. PASTE bahculg the Fields

Copy

| 5 Paste
Select All

6. RE-SAVE the Form Overlay

Error should be gone and fields properly linked to the View.

18
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Central Configuration Management
1. ITSM Server Configuration using Registry (i.e. GPO)

To provide a more seamless integration in a Windows domain environment the ITSM
Server configuration can be push to the clients using registry entries via a GPO or any
other deployment tool with registry capabilities. You will find bellow a simple
configuration example.

(i) You can add as many servers as needed in the global configurations. Just make
sure to provide each Server Item with a different global unique identifier. GUID
can be easily generated using an online GUID generator for example.

Description Action Hive Key Value Name Type Value Data Example

AR Server Name Update HKEY_CURRENT_USER SOFTWARE\ITSM40ffice\Servers\<GUID> ARServer REG_SZ itsmdev9

Item Order Update HKEY_CURRENT_USER SOFTWARE\ITSMA4O0ffice\Servers\<GUID> (default) REG_DWORD 0

Friendly Name Update HKEY_CURRENT_USER SOFTWARE\ITSM40ffice\Servers\<GUID> Name REG_SZ ITSM Prod

Scheme Update HKEY_CURRENT_USER SOFTWARE\ITSMA4O0ffice\Servers\<GUID> Scheme REG_SZ https

Server Type Update HKEY_CURRENT_USER SOFTWARE\ITSM40ffice\Servers\<GUID> Type REG_DWORD 0

URL Update HKEY_CURRENT_USER SOFTWARE\ITSM40ffice\Servers\<GUID> URL REG_SZ itsm.demo.itsm4outlook.com
Authentication Update HKEY_CURRENT_USER SOFTWARE\ITSM40ffice\Servers\<GUID> Authentication REG_DWORD 1

User ID Format Update HKEY_CURRENT_USER SOFTWARE\ITSMA40ffice\Servers\<GUID> Login REG_DWORD 0

User ID Update HKEY_CURRENT_USER SOFTWARE\ITSM40ffice\Servers\<GUID> UserlDTransformation = REG_DWORD 5

Transformation

Authentication Types Login Format Types UserID Transformations

Default

sAMAccountName RemoveBMCDomain

userPrincipalName RemoveDomain

Domain\Username RemoveEmailDomain
TolLowerCase
ToUpperCase

Unknown
Password

!  Note

Starting with Client version 2.1.7167.31338, global server configuration can also be
pushed to the HKLM (HKEY_LOCAL_MACHINE).

19
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=/ Group Policy Management Editor - o X
file Action View Help
e nmolEBmdz HE

Hive Key e Type
Update  HKEV_CURRENT_USER  SOFTWARELITS 4b829-2626-4b7b-aa11 ARServer REG_SZ itsmdevd
Updste  HKEV_CURRENT_ USER  SOFTWARE\IT: 4b329-2626-4bTb-aa1 1 REG.DWORD  00DO00D
Updste  HKEY_CURRENT_USER  SOFTWARENITS Name REG_SZ Demo
Updste  HKEY_CURRENT_USER  SOFTWAREVITS 1-96c510180251  Scheme REG_SZ http
Updste  HKEY_CURRENT_USER  SOFTWAREVITS 1-96c510180251  Type REG.DWORD 00000000
Updste  HKEY_CURRENT_USER  SOFTWARELITS 1-96c510180251  URL REG_SZ itsm.demo.itsmdoutlook.com

Processing

Eomwon g

> (3 Control Panel Settings

. 5
< > |\ Pesences
Collection

2. Add resiliency logic to prevent the ITSM4Outlook
Add-in being disable

Outlook’s resiliency logic, which was introduced with Outlook 2013, monitors add-in
performance metrics such as add-in startup, shutdown, folder switch, item open, and
invoke frequency. Outlook records the elapsed time in milliseconds for each
performance monitoring metric.

The resiliency logic is triggered when one of the Performance criteria is exceeded and
determine if an add-in should be disable.

Registry

To work around the resiliency logic, one can use registry entries to add the add-in to
the trusted addins list or a Group Policy Object to deploy the same values that would
be generated locally to all the users in the domain:

Add a REG_SZ entry called ITSM4OFFICE.ITSM40OUTLOOK with a value data of 1
under

HKEY_CURRENT _USER\SOFTWARE\Policies\Microsoft\Office\1x.0\Outlook\Resi
liency\AddinList

2. Set the LoadBehavior (US English spelling!) dword value to 3 under

HKEY_CURRENT_USER\SOFTWARE\Microsoft\Office\Outlook\Addins\ITSM4OF
FICE.ITSM40OUTLOOK

3. Delete the

HKEY_CURRENT_USER\SOFTWARE\Microsoft\Office\1x.0\Outlook\Resiliency\D

isableditems key

20
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4. Re-create the
HKEY_CURRENT_USER\SOFTWARE\Microsoft\Office\1x.0\Outlook\Resiliency\D
isableditems key

5. Delete the
HKEY_CURRENT_USER\SOFTWARE\Microsoft\Office\1x.0\Outlook\Resiliency\C
rashingAddinList key

6. Re-create the
HKEY_CURRENT_USER\SOFTWARE\Microsoft\Office\1x.0\Outlook\Resiliency\C
rashingAddinList key

7. Add a dword entry called ITSM4OFFICE.ITSM40OUTLOOK with a value of 1 under
HKEY_CURRENT_USER\SOFTWARE\Microsoft\Office\1x.0\Outlook\Resiliency\D
oNotDisableAddinList

8. Add a dword entry called ITSM4OFFICE.ITSM40OUTLOOK\dtype with a value of 0
under HKEY_CURRENT _USER\SOFTWARE\Microsoft\Office\1x.0\Outlook\Resilie
ncy\NotificationReminderAddinData

9. Add a dword entry called ITSM4OFFICE.ITSM40OUTLOOK with a value of 967a844d
hexadecimal or 2524611661 decimal under
HKEY_CURRENT_USER\SOFTWARE\Microsoft\Office\1x.0\Outlook\Resiliency\N

otificationReminderAddinData

Where:
e 1x.0is the office version, for example 15.0 for Office 2013 and 16.0 for Office 2016

() The value at point #1 will always enable the add-in but it will also prevent the user
from controlling the add-in load behavior. To allow users to control the add-in
(enable or disable it from the Outlook user interface), set a value data of “2"
instead.

(i) The value at point 9 always enables your add-in until Saturday, January 1st 2050
at 1:01:01 AM.

21
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GPO (Group Policy Object)

Name Order  Action Hive KeyValue Name Type ValueData

ITSM40ffice.ITSM40utlook 1 Create  HKEY_CURRENT_USER SOFTWARE\Policies\Microsoft\Office\1x.0\  ITSM4Office.ITSM4Outlook REG_SZ 1
Outlook\Resiliency\AddinList

LoadBehavior 2 Update HKEY_CURRENT_USER SOFTWARE\Microsoft\Office\Outlook\Addi LoadBehavior REG_DWORD 3
ns\ITSM40ffice.[TSM40Outlook

Disableditems 3  Delete HKEY_CURRENT_USER SOFTWARE\Microsoft\Office\1x.0\Outlook\
Resiliency\Disabledltems

Disableditems 4  Create HKEY_CURRENT_USER SOFTWARE\Microsoft\Office\1x.0\Outlook\
Resiliency\DisabledItems

CrashingAddinList 5 Delete  HKEY_CURRENT_USER SOFTWARE\Microsoft\Office\1x.0\Outlook\
Resiliency\CrashingAddinList

CrashingAddinList 6 Create HKEY_CURRENT_USER = SOFTWARE\Microsoft\Office\1x.0\Outlook\
Resiliency\CrashingAddinList

ITSM40ffice.ITSM40utlook 7 Create  HKEY_CURRENT_USER SOFTWARE\Microsoft\Office\1x.0\Outlook\ = ITSM40Office.ITSM4Outlook REG_DWORD 1
Resiliency\DoNotDisableAddinList

ITSM40ffice.ITSM40utlook 8 Create  HKEY_CURRENT_USER SOFTWARE\Microsoft\Office\1x.0\Outlook\ = ITSM4Office.I[TSM4Outlook\dtype = REG_DWORD 0
Resiliency\NotificationReminderAddinData

ITSM40ffice.ITSM40Outlook 9 Create HKEY_CURRENT_USER SOFTWARE\Microsoft\Office\1x.0\Outlook\  ITSM4Office.ITSM4Outlook REG_DWORD 967a844d

Resiliency\NotificationReminderAddinData

(D For reference and more information:

https://developermessaging.azurewebsites.net/2017/08/02/outlooks-slow-add-ins-resiliency-logic-and-how-to-always-enable-slow-add-ins/
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Server Component Removal

(1) Before doing any operation on the Remedy platform it is highly recommended
to perform a Database Backup to perform a roll back if needed.

1. Remedy Objects Clean-up

!  Note

The “ITSM for Office” Remedy Application might link to Out of the Box Component
like menus for example. DO NOT BULK REMOVE OBJECT DIRECTLY FROM THE
APPLICATION as you could remove critical OOTB components.

From the BMC Developer studio > All Objects > Forms

v" Search for all object starting with "ITSM40ffice” & "MSO"
v" Select them all and Delete them.

Forms - itsmdevd_iso) 51 | EIGH=]
~ Filtering Options
Display items where |Name ~ | | starts with ~ | | ITSM4Office
MName a Type Modified Access Point Custe ™
ITSNidOffice Application Profile “Reqular ST307E0TT 71451 BV fio i
%ITSMdDFﬁ(aCHG:Change\nteﬁa(e Open Join 3/16/2017 £:45:38 AM No Unmi
ITSM40ffice: CHG: TemplateQuerylnterface Open In Browser Join 5/30/2017 7:14:58 PM No Unmi
P! Ty P
&5 ITSMAOHice: CTM:SpriGrpFunRoleLookup SveCpySg K Delet Join 2/18/2017 8:13:45 PM Mo Unmi
&5 ITSM40ffice: CTM:Support Group Assoc LookUp Pec < Join 5/30/2017 7:15:01 PM Mo Unmq
&5 ITSMA0ffice: CTM:SuppertGroupFuncRoleLookUpPe Eapytlame Join 5/30/2017 T:15:01 PM Mo Unme
ITSMAOffice: Data: ClientScript Edit Regular 5/30/2017 7:14:51 PM No Unmq

Repeat the operation for the other objects:

e Active Links

e Filters

e Escalations

e Active Link Guides
o Filter Guides

e Web Services

e Menus
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Once all the relevant objects are removed you can delete the “ITSM for Office” Remedy
Application:

~ [ Applications
2 Analytics
& ApprovalAdminWeb
2 Approvallmage

[ inetorgperson
L ITSM for Office

Ll Kne MNew Application View by Form List
0 Myl
= My MNew Object >
Cd Myl Edit Application
0 Myl
5 Myl 30 Delete Application
ME£
% NO Export Application

2. Overview Console Clean-up

1. Browse the forms bellow and remove all record pointing to the "ITSM40Office
Overview Console” Implementation Area.
e SHR:Union_DataSource_FieldMappings
e SHR:Union_DataSource _Fields
e SHR:Union_DataSource_Forms
e SHR:Union_DataSource_UsedBy

2. At the DB level, drop all the "U_MSO_%" Views

mlfdbo.U_ M5O _CHG Change
) dbo.J__MSO_HPD_Incident

Ei—_] dba.U__Ma0_OverviewConsale
] dbo.l__MSO_PEM_Known_Errar
3 dho.__MSO_PEM_Problem

£ dho.J__MSO_TMS_Task

£ dho.J__MSO_WOI_workOrder
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